
Chapter 1
Introduction to 

AutoCAD MEP

 Learning Objectives  
After completing this chapter, you will be able to:
•	Start AutoCAD MEP
•	Use the components of the AutoCAD MEP interface
•	Invoke AutoCAD MEP commands from the keyboard, menu, toolbar, shortcut menu, 

TOOL PALETTES, and Ribbon
•	Use the components of dialog boxes in AutoCAD MEP
•	Start a new drawing
•	Save work using various file-saving commands
•	Close a drawing
•	Open an existing drawing
•	Exit AutoCAD MEP
•	Use various options of AutoCAD MEP help
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INTRODUCTION
AutoCAD MEP is based on the  AutoCAD Architecture platform. Since it belongs to the AutoCAD 
family, it has all the features of AutoCAD such as Blocks, Layers, 3D Models, and so on. Also, 
the software has all the important architectural features such as walls, doors, windows, and so 
on. AutoCAD MEP is also referred to as AMEP where MEP stands for Mechanical, Electrical, 
and Plumbing. Therefore, the software has all the required features for creating a Mechanical, 
Electrical, and Plumbing system. In this chapter, you will learn to start AutoCAD MEP and use 
various components displayed in the AutoCAD MEP interface. 

GETTING STARTED WITH AutoCAD MEP
When you install AutoCAD MEP 2023 on your system, three shortcuts pointing to the AutoCAD 
MEP 2023 - English (Global), AutoCAD MEP 2023 - English (US Imperial), and AutoCAD 
MEP 2023 - English (US Metric) will be created on the desktop. You can start AutoCAD MEP by 
double-clicking on any of these three icons. In AutoCAD MEP 2023 -English (US Imperial), the units 
available in drawing will be in Inch, Feet, and Mile. In AutoCAD MEP 2023 - English (US Metric), 
the units available in the drawing will be in Millimeter, Centimeter, and Meter. In AutoCAD 
MEP 2023 - English (Global), AutoCAD MEP will start using the global template. 

Note
In this textbook, the global unit system is followed, so you need to start AutoCAD MEP 2023 by 
double-clicking on the AutoCAD MEP 2023 - English (Global) icon on the desktop.

AutoCAD MEP INTERFACE COMPONENTS
When you start AutoCAD MEP 2023 for the first time, you will get the startup interface window, 
as shown in Figure 1-1.

Figure 1-1  The startup interface window of AutoCAD MEP 2023
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Start Tab
In AutoCAD MEP 2023, the Start tab is displayed with the startup interface window. It provides 
options for easy access to a variety of initial actions, including access to drawing template files, 
recently opened drawings and sheet sets, online learning options, and announcements. The 
options available in the Start tab are discussed next.

Open
On choosing this button, the Select File dialog box is displayed which allows you to open the 
existing drawing files. The drop-down list next to the Open button has three more options other 
than the Open files options. These options are used to open the existing projects, the sheet sets 
and explore the sample drawings.

New
On choosing this button, a new drawing file will be created from the default drawing template file.
The drop-down list next to the New button enables you to view the most recently used templates, 
view the list of all available drawing template files, helps download additional drawing template 
files when available, and create sheet sets.

Recent
This page is displayed by default and has the options to view the most recently used documents. 
You can keep a document listed by pinning it. A pinned document is displayed at the top of the 
list until you unpin it. You can also choose between the display options for image and text or 
text only by choosing the two swatch buttons available in the Recent area.

Autodesk Docs
This page provides options to open and save files to your connected drives. You will need to 
have Desktop Connector installed to access the connected drives on Autodesk Docs.

Learning
This page provides options to access the learning resources such as videos, tips, and other 
relevant online content or services if available. You need to have an active internet connection to 
access the  options available in this page. Under the Learning head, links are provided to access 
other online resources or topics. such as what’s new, online help, community forum, customer 
support, AutoCAD mobile app, and AutoCAD web app. Figure 1-2 shows the Learning page.
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Figure 1-2  The startup interface window of AutoCAD MEP 2023 with the Learning page

Drawing Area
Choose the New button to open the drawing area. The drawing area covers a major portion of 
the screen. In this area, you can draw objects and use the commands. To draw the objects, you 
need to define the coordinate points. Position of the pointing device is represented on the screen 
by the cursor. There is a coordinate system icon at the lower left corner of the drawing area. The 
drawing area also has the standard windows buttons such as close, minimize, and maximize on 
the top right corner. These buttons have the same functions as in any other standard window. 
Figure 1-3 shows the AutoCAD MEP drawing interface components.

Figure 1-3  AutoCAD MEP drawing interface components
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Command Window
The command window available at the bottom of the drawing area has the command prompt 
where you can enter the commands. It also displays the subsequent prompt sequences and 
messages. You can change the size of the window by placing the cursor on the top edge (double 
line bar known as the grab bar) and then dragging it. This way you can increase its size to see 
all the previous commands you have used. By default, the command window displays only two 
lines. You can also press the F2 key to display the AutoCAD Text window, which displays the 
previous commands and prompts.

ViewCube
The ViewCube is available at the top right corner of the drawing area and is used to switch 
between standard and isometric views or roll the current view. 

In-Canvas Viewport Controls
In-Canvas Viewport Controls is available at the top left corner of the drawing screen. It enables 
you to change the drawing view, visual style, and the viewport.

Application Status Bar
The Application Status Bar is located at the bottom of the interface. This bar is also referred to 
as the Status bar. It contains some useful information and buttons, refer to Figure 1-4, that help 
you in changing the status of some AutoCAD MEP functions. You can toggle between the on and 
off states of most of these functions by using the corresponding options. You can customize the 
Application Status Bar by using the Customization button available on the right on the Status 
Bar. Some of the options in the Application Status Bar are discussed next.

 Figure 1-4  The Application Status Bar

Drawing Coordinates
The information about the coordinates is displayed at the lower left corner of the Status bar. 
The COORDS system variable controls the display type of the coordinates. If the value of the 
COORDS variable is set to 0, the coordinate display is static, that is, the coordinate values 
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displayed in the Status bar will change only when you specify a point. If the value of the COORDS 
variable is set to 1 or 2, the coordinate display will be dynamic. When the variable is set to 1, 
AutoCAD MEP constantly displays the absolute coordinates of the cursor with respect to the UCS 
origin. The relative polar coordinates (length<angle) are displayed when you are in an AutoCAD 
MEP command and the COORDS variable is set to 2. Click on the Drawing Coordinates area 
to toggle the coordinate status from on to off and vice versa. 

Model or Paper space
The Model or Paper space button is used to toggle between the model space and the paper space.

GRIDMODE
The GRIDMODE button is used to toggle the display of  the grid lines on and off on the screen. 
In AutoCAD MEP, the grid lines are used as reference lines to draw objects. The F7 function key 
can be used to turn the grid display on or off.

SNAPMODE
On choosing this button, you can move the cursor in fixed increments. The F9 key acts as a 
toggle key to turn the snap off or on. 

Infer Constraints
If this button is chosen, then some of the geometric constraints will be automatically applied to 
the sketch while it is being drawn. 

Dynamic Input
The Dynamic Input button is used to turn the Dynamic Input mode on or off. Turning it on 
facilitates the heads-up design approach because all commands, prompts, and dimensional 
inputs will now be displayed in the drawing area and you do not need to look at the command 
prompt all the time. This saves the design time and also increases the efficiency of the user. If 
the Dynamic Input mode is turned on, you will be able to enter the commands through the 
Pointer Input boxes, and the numerical values through the Dimensional Input boxes. You will 
also be able to select the command options through the Dynamic Prompt options in the graphics 
window. To turn the Dynamic Input mode on or off, use the F12 key. 

ORTHOMODE
On choosing the ORTHOMODE button, you can draw lines at right angles only. You can use 
the F8 function key to turn the ortho mode on or off.

Polar Tracking
The Polar Tracking button is used to turn the polar tracking on. If you turn the polar tracking 
on, the movement of the cursor is restricted along a path based on the angle set as the polar 
angle. You can also use the F10 function key to turn on this option. Note that turning the polar 
tracking on, automatically turns off the ortho mode.   

Isometric Drafting
In AutoCAD MEP 2023, you can create an isometric drafting by using any working plane. To 
activate a required working plane, choose the Isometric Drafting button from the Status Bar; 
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a flyout will be displayed with the isoplane Left, isoplane Top, or isoplane Right option. You 
can choose the required option from this flyout to activate the respective work plane.

Object Snap Tracking
This button is used to turn the object snap tracking on or off. On choosing this button, the 
inferencing lines will be displayed. Inferencing lines are dashed lines displayed automatically 
when you select a sketching tool and track a particular key point on the screen. You can also 
choose the F11 function key to turn on or off the object snap tracking.

Object Snap
On choosing the Object Snap button, you can use the running object snaps to snap on to a point. 
You can also use the F3 function key to turn the object snap on or off. The status of OSNAP (off 
or on) does not prevent you from using the immediate mode object snaps.

Show/Hide Lineweight
This button is used to turn on or off the display of line weights in the drawing. If this button is 
not chosen, the display of lineweight will be turned off.

Transparency
This button is used to turn on or off the transparency set for a drawing. You can set the 
transparency in the Properties panel or in the layer in which the sketch is drawn.

Selection Cycling
On choosing this button, you can cycle through and select the overlapping objects close to the 
other entities. On selecting an entity when this button is chosen, the Selection list box will be 
displayed with a list of entities.

3D Object Snap
On choosing this button, you can snap the key point on a solid or a surface body. You can also
use the F4 function key to turn on or off the 3D object snap.

Dynamic UCS
This button is used to enable or disable the use of dynamic UCS. Allowing the dynamic UCS 
ensures that the XY plane of the UCS gets dynamically aligned with the selected face of the 
model. You can also use the F6 function key to turn the Dynamic UCS button on or off.

Filters object selection
You can filter objects by using the Filters object selection button. If you want to select only 
vertex, edge, face, solid history, or the drawing view components of a 3D object then you can 
choose the required option from the flyout which is invoked by clicking on the small arrow 
located on right of the Filters object selection button. You can also select multiple objects using 
the selection window.

The Drawing View Components option is used to select the components of an assembly or 
the parts in a multi-body. Using this option, you can select components either individually or 
through window selection. You can also clear the filters by choosing the Filter object selection 
button again.
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Show gizmos
You can move, rotate, and scale a 3D object by choosing the Show gizmos button from the Status 
Bar. When you click on the small arrow available next to the Show gizmos button, a flyout is 
displayed with the Move Gizmo, Rotate Gizmo, and Scale Gizmo options.

Show annotation objects
This button is used to control the visibility of the annotative objects that do not support the 
current annotation scale in the drawing area.

Add scales to annotative objects when the annotation scale changes
If this button is chosen then the annotation scales that are set current to all the annotative objects 
present in the drawing are applied automatically to the drawing. 

Annotation scale of the current view
The annotation scale controls the size and display of the annotative objects in the model space. 
When you choose this button, a flyout will be displayed showing all the annotation scales available 
for the current drawing.

Workspace Switching
When you choose this button, a flyout is displayed. You can use the options in this flyout to switch 
between different workspaces like HVAC, Piping, Electrical, and so on. You can also customize 
a workspace or create a new workspace by using the options in this flyout.

Annotation Monitor                   

Figure 1-5  The non-associative annotation

The Annotation Monitor button is used to turn 
the Annotation Monitor on or off. If it is turned 
on, all the non-associative annotations will get 
highlighted with a badge placed on them, as shown 
in Figure 1-5. In this figure, a line leader is not 
associated with line.

Current drawing units
The Current drawing units button displays and 
controls the units of drawing. When you choose 
this button, a flyout is displayed. This flyout shows 
all the unit systems available for the drawing.  

Quick Properties
On choosing this button, the properties of the selected sketched entity will be displayed in a panel.
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Display Configuration
When you choose this button, a flyout will be displayed with MEP Design option as the default 
chosen configuration. Options available in this flyout are used to control the level of details 
of the objects created in the drawing area. The options in the flyout are arranged according 
to their area of application. For example, the options related to the Electrical workspace are 
grouped together. 

Global Cut Plane
When you click on the Global Cut Plane button in the

Figure 1-6  The Global Cut Plane 
dialog box

 
Application Status Bar, the Global Cut Plane dialog box will 
be displayed, as shown in Figure 1-6.  This dialog box is used 
to specify the cut plane height and display range for the objects 
in the drawing area. 

Replace Z value with current elevation
This toggle button is used to replace the elevation value with 
the specified Z value. When this toggle button is chosen, the 
components are created on the plane having the elevation 
equal to the Z value entered for the previously created 
component.

Elevation
The elevation icon displays a value of the current elevation. To specify elevation, click on the 
elevation value displayed in the Application Status Bar; the Elevation Offset dialog box will 
be displayed. You can set the elevation either by specifying the Z offset value or by picking a 
point from the drawing.

Isolate Objects
When you choose this button, a flyout is displayed. There are two options in this flyout: Isolate 
Objects and Hide Objects. Using the Isolate Objects option, you can isolate the selected objects 
so that only the selected objects are displayed in the drawing area. If some objects are already 
isolated, then the Isolate Objects button will be highlighted in blue color in the Application 
Status Bar. To end isolation or display a hidden object, choose this button again; a flyout will 
be displayed. Now, choose the End Object Isolation option from the flyout. To hide objects, 
choose the Hide Objects option from the flyout.

Hardware Acceleration
This button is used to set the performance of the software to the required level. Right-click on 
this button; a flyout with Graphic Performance option will be displayed. Choose this option;  
the Graphic Performance dialog box will be displayed. By using the options in this dialog box, 
you can control the performance of software.

Catalog Status
This button is used to check the status of equipment in the MEP database. If the database is 
not updated then you can regenerate the database by using this button. To do so, double-click 
on the Catalog Status button in the Application Status Bar; you will be prompted to specify 



1-10			                	       AutoCAD MEP 2023 for Designers
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

the name of catalog for which you want to regenerate the database. There are five catalogs in 
AutoCAD MEP: Cabletray, Conduit, Duct, Mvpart, and Pipe. You can update any of the catalogs by 
specifying its name or you can update all the catalogs by specifying All at the command prompt.

Surface Hatch Toggle
Using this button, you can toggle on or off the display of the surface hatch in the drawing area.

Layer Key Overrides
The Layer Key Overrides button is used to enable or disable the overrides applied on the layers 
available in the drawing file. When you choose this button, the Layer Key Overrides dialog 
box will be displayed, refer to Figure 1-7. Using the options available in this dialog box, you 
can configure the presets for any of the layers available in the drawing. Also, you can enable or 
disable the overrides for any of the layers available. 

Figure 1-7  The Layer Key Overrides dialog box

Clean Screen
This button is used to display the expanded view of the drawing area by hiding all the toolbars 
except the command window, Status Bar, and menu bar. The expanded view of the drawing 
area can also be displayed by using the CTRL+0 keys. Choose the Clean Screen button again 
to restore the previous display state.

Customization
This button is used to add or remove tools in the Application Status Bar.

Plot/Publish Details Report Available 
This icon is displayed in the Application Status Bar when a plotting or publishing activity 
is being performed in the background or is completed. When you click on this icon, the 
Plot and Publish Details dialog box, which provides the details about the plotting and 

publishing activity, will be displayed. You can copy this report to the clipboard by choosing the 
Copy to Clipboard button from the dialog box.
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Invoking Commands in AutoCAD MEP
When you are in the drawing area in AutoCAD MEP,\ you need to invoke AutoCAD MEP 
commands to perform any operation. For example, to draw a pipe line, enter the PIPEADD 
command at the command prompt and then define the start point and the endpoint of the pipe. 
Similarly, if you want to erase objects, you must invoke the ERASE command and then select 
the objects for erasing.  In AutoCAD MEP, you can invoke the commands by using:

Command Prompt	 Ribbon			  Application Menu	 TOOL PALETTES	
Menu Bar		  Shortcut Menu              Toolbar

Command Prompt
You can invoke any AutoCAD MEP command from the command prompt by typing the command 
name and then pressing ENTER. As you type the first letter of the command, AutoCAD MEP 
displays all the available commands starting with the letter typed. If the Dynamic Input is on 
and the cursor is in the drawing area, by default the command will be entered through the 
Pointer Input box. The Pointer Input box is a small box displayed on the right of the cursor. 
However, if the cursor is currently placed on any toolbar or menu bar, or if the Dynamic Input 
is turned off, the command will be entered through the Command Prompt. Before you enter 
a command, the Command Prompt is displayed as the last line in the command window area. 
If it is not displayed, you must cancel the existing command by pressing the ESC (Escape) key. 
The following example shows how to invoke the LINE command by using the keyboard:

Command: LINE or L    (L is command alias) 

Ribbon
In AutoCAD MEP, you can also invoke a tool from the Ribbon. When you start the AutoCAD MEP 
session for the first time, by default, the Ribbon is displayed below the Quick Access Toolbar. 
The Ribbon consists of various tabs. The tabs have different panels which in turn have tools 
arranged in rows. For example, the tools for creating, modifying, and annotating the objects are 
available in the Annotate tab in panels instead of being spread out in the entire drawing area 
in different toolbars and menus, refer to Figure 1-8.

Figure 1-8 The Ribbon with the Annotate tab chosen 

Some of the tools have small black down arrows. This indicates that the tools having similar 
functions are grouped together. To choose a tool, click on the down arrow; a drop-down will be 
displayed. Choose the required tool from the drop-down displayed. Note that if you choose a 
tool from the drop-down, the corresponding command will be invoked and the tool that you have 
chosen will be displayed in the panel. For example, to draw a circle using 2 points, click on the 
down arrow next to the Circle, Center, Radius tool in the Draw panel of the Home tab; a flyout 
will be displayed. Choose the Circle, 2-Point tool from the flyout and then draw the circle. You 
will notice that the Circle, 2-Point tool is displayed in place of the Circle, Center, Radius tool.  
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You can click on the down arrow to expand the panel. On doing so, you will notice that a push 
pin is available at the left corner of the panel. Click on the push pin to keep the panel in the 
expanded state. Also, some of the panels have an inclined arrow at the lower-right corner. When 
you left click on an inclined arrow, a dialog box is displayed. You can define the setting of the 
corresponding panel in the dialog box. 

You can reorder the panels in the tab. To do so, press and hold the left mouse button on the 
panel to be moved and drag it to the required position. You can also undock the Ribbon. To do 
so, right-click on the blank space in the Ribbon and choose the Undock option; the Ribbon gets 
undocked. Now you can move, resize, anchor, and auto-hide the Ribbon using the shortcut menu 
that will be displayed when you right-click on the heading strip. To anchor the floating Ribbon 
to the left or right of the drawing area in the vertical position, right-click on the heading strip 
of the floating Ribbon; a shortcut menu is displayed. Choose the corresponding option from 
this shortcut menu. The Auto-hide option will hide the Ribbon into the heading strip and will 
display it only when you move the cursor over this strip.

You can customize the display of tabs and panels in the Ribbon. To customize the Ribbon, 
right-click on any one of the tools in it; a shortcut menu will be displayed. On moving the cursor 
over one of the options, a flyout will be displayed with a tick mark before all options and the 
corresponding tab or panel will be displayed in the Ribbon. Select/clear appropriate option to 
display/hide a particular tab or panel.

Application Menu
The Application Menu is available at the top-left of the

Figure 1-9  The Application Menu

 
AutoCAD MEP window. It contains some of the tools that 
are also available in the Quick Access Toolbar. Click on the 
down arrow on the Application Menu to display the tools, 
as shown in Figure 1-9. You can search a command using 
the search field on the top of the Application Menu. To 
search a tool, enter the complete or partial name of the 
command in the search field; the relevant tool list will be 
displayed. If you click on a tool from the list, the 
corresponding command will get activated. 

By default, the Recent Documents button is chosen in the 
Application Menu. Therefore, the recently opened drawings 
will be displayed. If you have opened multiple drawing files, 
choose the Open Documents button; the documents that are 
opened will be listed in the Application Menu. To set the 
preferences of the file, choose the Options button available 
at the bottom of the Application Menu. To exit AutoCAD 
MEP, choose the Exit AutoCAD MEP 2023 button next to 
the Options button. 

TOOL PALETTES
The TOOL PALETTES in AutoCAD MEP help you to place and share hatch patterns and blocks 
in the current drawing in a convenient way. By default, the TOOL PALETTES are displayed 
on the left in the drawing area. If the TOOL PALETTES is not displayed then choose Tools 
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from the Tools drop-down in the Build panel of the Home tab in the Ribbon or choose the 
CTRL+3 keys to display the TOOL PALETTES. You can resize the TOOL PALETTES using 
the resizing cursor that is displayed when you place the cursor on the top or bottom extremity 
of the TOOL PALETTES. The TOOL PALETTES will be discussed in detail in later chapters.

Quick Access Toolbar
The Quick Access Toolbar is a customizable toolbar located at the top of the application window, 
just to the right of the Application Menu. By default, this toolbar contains a set of frequently 
used commands for the application. You can add or remove tools as needed. To add the tool 
to the Quick Access Toolbar, locate the tool and then right-click on it; a shortcut menu will be 
displayed. Next, choose the Add to Quick Access Toolbar option; the tool will be added to the 
Quick Access Toolbar. To remove the tool from the Quick Access Toolbar, right-click on the 
tool and then choose the Remove from Quick Access Toolbar option.

Share Drawing                
This tool is available next to the Quick Access Toolbar. It allows you to share a link to a copy 
of the current drawing to view or edit in the AutoCAD web app. The drawing copy includes all 
external references and images contained in the current drawing. Anyone having the link can 
access the drawing in the AutoCAD web app. The link expires seven days after it is created. You 
can choose between two permission levels for recipients: View only and Edit and save a copy.

Menu Bar
You can also select commands from the menu bar. Menu bar is not displayed by default. To 
display the menu bar, choose the down arrow in the Quick Access Toolbar; a flyout is displayed. 
Choose the Show Menu Bar option from it; a menu bar will be displayed. You can invoke a 
command by left-clicking on the menu. In AutoCAD MEP, there are three menus available: File, 
Window, and Help menus. The File menu has the options to manage the drawing file. Using 
the options available in the Window menu, you can close the current session, switch between 
two sessions, or can display multiple sessions in the display window. The options in the Help 
menu are used to display the help documentation.

Shortcut Menu
AutoCAD MEP has provided shortcut menus as an easy and convenient way of invoking the 
recently used tools. These shortcut menus are context-sensitive, which means that the tools present 
in them are dependent on the place/object for which they are displayed. A shortcut menu is 
invoked by right-clicking and is displayed at the cursor location. You can right-click anywhere in 
the drawing area to display the general shortcut menu. It generally contains an option to select 
the previously invoked tool again apart from the common tools, refer to Figure 1-10.

Figure 1-10  Partial view of shortcut menu with the recently used commands
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If you right-click in the drawing area while a command is active, a shortcut menu with the 
options related to that particular command will be displayed. Figure 1-11 shows the shortcut 
menu when the Duct tool is active.

If you right-click on the Start Tab, a shortcut menu will be displayed that contains the options 
for creating new drawings, refer to Figure 1-12.

You can also right-click on the command window to display a shortcut menu. This menu displays 
the six most recently used commands and some of the Windows options like Copy and Paste, 
refer to Figure 1-13. The commands and their prompt entries are displayed in the History 
window (previous command lines not visible) and can be selected, copied, and pasted in the 
command line using the shortcut menu. As you press the up arrow key, the previously entered 
commands are displayed in the command window. Once the desired command is displayed 
at the command prompt, you can execute it by simply pressing the ENTER key. You can also 
copy and edit any previously invoked command by locating it in the History window and then 
selecting the command lines. After selecting the desired command lines from the History window, 
right-click to display a shortcut menu. Choose Copy from the menu and then paste the selected 
lines at the end of the command line.

You can right-click on the coordinate display area of the Application Status Bar to display a 
shortcut menu. This menu contains the options to modify the display of coordinates, as shown 
in Figure 1-14.  

Figure 1-11  Shortcut 
menu displayed when 
the Duct tool is active

Figure 1-12  Shortcut 
menu for the Start Tab
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Figure 1-13  Command line 
window shortcut menu

Figure 1-14  The Coordinate 
shortcut menu

AutoCAD MEP DIALOG BOXES
There are certain commands, which when invoked, display a dialog box. When you choose an 
item from the menu, a dialog box is displayed. For example, when you choose New from the 
File menu, the Select template dialog box is displayed. In the Application Menu, when you 
choose an item, it may display a dialog box, although there are no ellipses with that item. For 
example, when you choose Options from the Application Menu, the Options dialog box is 
displayed. A dialog box contains a number of parts like the dialog label, radio buttons, text or 
edit boxes, check boxes, slider bars, image boxes, and command buttons. These components 
are also referred to as tiles. Some of the components of a dialog box are shown in Figure 1-15.

You can select the desired tile using the pointing device, which is represented by an arrow when 
a dialog box is invoked. The titlebar displays the name of the dialog box. The tabs specify the 
various sections with a group of related options under them. The check boxes provide toggle 
options for making a particular option available or unavailable. The drop-down list displays 
an item and an arrow on the right which when selected displays a list of items to choose from. 
You can make a selection in the radio buttons. Only one can be selected at a time. The preview 
displays the preview image of the item selected. The text box is an area where you can enter a 
text like a file name. It is also called an edit box because you can make any change to the text 
entered. In some dialog boxes, there is the [...] button, which displays another related dialog 
box. There are certain buttons (OK, Cancel, Apply, and Help) at the bottom of the dialog box. 
The name implies their functions. The button which is highlighted is the default button. The 
Help button in this dialog box is used to display help on various features of the dialog box.
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Figure 1-15  Components of a dialog box

STARTING A NEW DRAWING
  Application Menu:   New > Drawing	 Command:    NEW		   
  Quick Access Toolbar:  New		  Menu Bar:    File > New		

You can open a new drawing using the New tool in the File menu. When you invoke the 
New tool, by default the Select template dialog box will be displayed, as shown in 
Figure 1-16. This dialog box displays a list of default templates available in AutoCAD 

MEP 2023. The default selected template is Aecb Model (Global Ctb).dwt, which starts the 
AutoCAD MEP environment with global unit system. You can select any other template to start 
a new drawing. The drawing will use the settings of the selected template. You can also open 
any drawing without using any template either in metric or imperial system. To do so, choose 
the down arrow on the right of the Open button from the Select template dialog box and select 
the Open with no Template-Metric option or the Open with no Template-Imperial option 
from the flyout.  

You can also open a new drawing using the Use a Wizard and Start from Scratch options 
from the Create New Drawing dialog box. To invoke the Create New Drawing dialog 
box, enter STARTUP at the command prompt and then enter 1 as the new value for 
this system variable. Invoke the New tool; the Create New Drawing dialog box will be 
displayed, as shown in Figure 1-17. The options in this dialog box are discussed next.
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Figure 1-16   The Select template dialog box

Figure 1-17  The default templates displayed in the Create New Drawing 
dialog box on choosing the Use a Template button

Note
If you have started a new AutoCAD MEP session with the STARTUP variable set to 1 then the 
Startup dialog box will be displayed. The options in the Startup dialog box are same as that of 
the Create New Drawing dialog box with the only difference that in the Startup dialog box, the 
Open a Drawing button will be activated.
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Open a Drawing
By default, this option is not available. You can access this option only when you start a new 
session of AutoCAD MEP. You can open a drawing by using the Open button which is discussed 
later in this chapter.

Use a Template
When you choose the Use a Template button from the Create New Drawing dialog box, AutoCAD 
MEP displays a list of templates, refer to Figure 1-17. The default selected template file is Aecb 
model (global ctb).dwt. You can select any of the template files from the list. The new drawing will 
have the same settings as specified in the template file. The preview of the template file selected 
is displayed in the dialog box. You can also define your own template files that are customized 
to your requirements. You can differentiate the template files from the drawing files through 
their extensions. The template files have a .dwt extension whereas the drawing files have a .dwg 
extension. Any drawing file can be saved as a template file. You can use the Browse button to 
select other template files. When you choose the Browse button, the Select a template file dialog 
box is displayed with the Template folder open, displaying all the template files.

Start from Scratch
When you choose the Start from Scratch button, refer to Figure 1-18, AutoCAD MEP provides you 
with options to start a new drawing that contains the default AutoCAD MEP setup for Imperial 
or Metric drawing. If you select the Imperial(feet and inches) option from the Default Settings 
area, the limits are 12X9, text height is 0.20, and dimension and linetype scale factor is 1.

Figure 1-18  The Create New Drawing dialog box with the Start 
from Scratch button chosen 

Use a Wizard
The Use a Wizard button allows you to set the initial drawing settings before actually starting 
a new drawing. When you choose the Use a Wizard button, the Quick Setup and Advanced 
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Setup options are displayed in the Select a Wizard area, refer to Figure 1-19. If you select the 
Quick Setup option, you can specify the units and the limits of the work area. If the Advanced 
Setup option is selected, then you can set the units, limits, and the other types of settings for a 
drawing. These options are discussed next.

Figure 1-19  The wizard options displayed on choosing the Use 
a Wizard button

Advanced Setup
This option allows you to preselect the parameters of a new drawing such as the units of linear 
and angular measurements, type and direction of angular measurements, approximate area 
desired for the drawing, precision for displaying the units after decimal, and so on. When you 
select the Advanced Setup wizard option from the Create New Drawing dialog box and choose 
the OK button, the Advanced Setup wizard will be displayed. The Units page is displayed by 
default, as shown in Figure 1-20. 

This page is used to set the units for measurement in the current drawing. The different units 
of measurement that you can choose from are Decimal, Engineering, Architectural, Fractional, 
and Scientific. You can select the required unit of measurement by selecting the respective radio 
button. You will notice that the preview image is modified accordingly. You can also set the 
precision for the measurement units by selecting it from the Precision drop-down list.

Choose the Next button to open the Angle page, as shown in Figure 1-21. You will notice that 
an arrow appears on the left of Angle in the Advanced Setup wizard. This suggests that this 
page is current. 

This page is used to set the unit for angular measurements and its precision. The units for angle 
measurement are Decimal Degrees, Deg/Min/Sec, Grads, Radians, and Surveyor. The units for 
angle measurement can be set by selecting any one of these radio buttons as required. The 
preview of the selected angular unit is displayed on the right of the radio buttons. The precision 
format changes automatically in the Precision drop-down list depending on the angle measuring 
system selected. You can then select the precision from the drop-down list. 
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Figure 1-20  The Units page of the Advanced Setup wizard

Figure 1-21  The Angle page of the Advanced Setup wizard

The next page is the Angle Measure page, as shown in Figure 1-22. This page is used to select 
the direction of the baseline from which the angles will be measured. You can also set your 
own direction by selecting the Other radio button and then entering the value in the edit 
box displayed below it. This edit box gets activated only when you select the Other radio button. 
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Figure 1-22  The Angle Measure page of the Advanced Setup wizard

Choose Next to display the Angle Direction page to set the orientation for the angle measurement, 
refer to Figure 1-23. By default the angles are positive if measured in a counterclockwise direction. 
This is because the Counter-Clockwise radio button is selected. If you select the Clockwise 
radio button, the angles will be considered positive when measured in the clockwise direction. 
To set the limits of the drawing, choose the Next button; the Area page will be displayed, as 
shown in Figure 1-24. You can enter the width and length of the drawing area in the respective 
edit boxes.

Figure 1-23  The Angle Direction page of the Advanced Setup wizard
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Figure 1-24  The Area page of the Advanced Setup wizard

Note
Even after you increase the limits of the drawing, the drawing display area does not increase. You 
need to invoke the Zoom All tool from the Navigation Bar to increase the drawing display area.

Quick Setup 
When you select the Quick Setup option from the Create New Drawing dialog box and choose 
the OK button, the QuickSetup wizard is displayed. This wizard has two pages: Units and Area. 
The Units page is opened by default, as shown in Figure 1-25. The options in the Units page 
are similar to those in the Units page of the Advanced Setup wizard. The only difference is that 
you cannot set the precision for the units in this wizard. 

Choose Next to display the Area page, as shown in Figure 1-26. The Area page of the QuickSetup 
is similar to that of the Advanced Setup wizard. In this page, you can set the drawing limits.

Tip
When you open an AutoCAD MEP session, a drawing will be opened automatically. But you 
can open a new drawing using the options such as Start from Scratch and Use a Wizard from 
the Startup dialog box before entering into AutoCAD MEP environment. As mentioned earlier, 
the display of the Startup dialog box is turned off by default. Refer to the section Starting a 
New Drawing to know how to turn on the display of this dialog box.
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Figure 1-25  The Units page of the QuickSetup wizard

Figure 1-26  The Area page of the QuickSetup wizard

SAVING WORK
The QSAVE, SAVEAS, and SAVE commands allow you to save your work. When you 
choose the Save tool from the Quick Access Toolbar, the QSAVE command is invoked. 
If you are saving the drawing for the first time in the present session, the SAVEAS 

command will be invoked in place of the QSAVE command and you will be prompted to enter 
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the file name in the Save Drawing As dialog box, as shown in Figure 1-27. You can enter the 
name for the drawing and then choose the Save button. If you have modified a drawing file, 
choose the Save tool to save it; the system saves the file without prompting you to enter a file 
name. This allows you to do a quick save.

When you choose Save As from the Application menu or choose the Save As tool from the 
Quick Access Toolbar, the Save Drawing As dialog box will be displayed, refer to Figure 1-27. 
Even if the drawing has been saved with a file name, by using this tool, you can specify a new 
name for the drawing. You can also use this tool when you make certain changes to a template 
and want to save the changed template drawing but leave the original template unchanged.

Figure 1-27  The Save Drawing As dialog box

The options in the Save Drawing As dialog box are discussed next.

Places List
A column of icons is displayed on the left side of the dialog box. These icons contain the 
shortcuts to the folders that are frequently used. You can quickly save your drawings in one of 
these folders. The History folder displays the list of the most recently saved drawings. You can 
save your personal drawings in the Documents folder. The Desktop folder displays the list of 
contents on the desktop. You can rearrange all these folders by dragging them and then placing 
them at the desired locations. It is also possible to remove the folders which are not in frequent 
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use. To do so, right-click on the particular folder and then choose Remove from the shortcut 
menu. Now, you can also save the document on Autodesk Cloud. The option for saving the 
document is discussed next.

File name
To save your work, enter the name of the drawing in the File name edit box by typing or by 
selecting it from the drop-down list. If you have already assigned a name to the drawing, it will 
be displayed in the edit box as the default name. If the drawing is unnamed, the default name 
Drawing1 will be displayed in the File Name edit box. 

Files of type
The options in the Files of type drop-down list are used to specify the drawing format in which 
you want to save the file, refer to Figure 1-28. For example, to save the file as an AutoCAD 2007 
drawing file, select AutoCAD 2007/LT 2007 Drawing (*.dwg) from the drop-down list.

Figure 1-28  The Files of type drop-down list

Save in 
The current drive and path information is listed in the Save in drop-down list. AutoCAD MEP 
will initially save the drawing in the default folder, but if you want to save the drawing in a 
different folder, you have to specify the path. For example, to save the present drawing as 
house in the C1 folder, choose the arrow button in the Save in drop-down list to display the 
drop-down list. Select C: from the drop-down list; all folders in the C drive will be listed in 
the File list box. Double-click on the C1 folder, if it is already listed there or create a new 
folder with the name C1 by choosing the Create New Folder button. Select house from the 
drop-down list, if it is already listed there, or enter it in the File name edit box and then 
choose the Save button. Your drawing (house) will be saved in the C1 folder (C:\C1\house.dwg). 
Similarly, to save the drawing in the D drive, select D: from the Save in drop-down list.
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Tip 
The file name you enter to save a drawing should match its contents. This helps you to remember 
the drawing details and makes it easier to refer to them later. Also, the file name can be 255 
characters long and can contain spaces and punctuation marks.

Views
The options in this drop-down list, refer to Figure 1-29, are used to set

Figure 1-29  The Views 
drop-down list

 
the appearance of the files and folders to specific view and they are 
discussed next.

List, Details, and Thumbnails Options
If you choose the Details option, it will display the detailed information 
about the files (size, type, date, and time of modification) in the Files 
list box. In the detailed information, if you click on the Name label, the files will be  listed with 
the names in alphabetical order. If you double-click on the Name label, the files will be listed in 
reverse order. Similarly, if you click on the Size label, the files are listed according to their size 
in ascending order. Double-clicking on the Size label  will list the files in descending order of 
size. Similarly, you can click on the Type label or the Modified label to list the files accordingly. 
If you choose the List option, all files present in the current folder will be listed in the File list 
box. If you select the Thumbnails option, the list box displays the preview of all the drawings, 
along with their names displayed at the bottom of the drawing preview. Also, the preview of the 
file is displayed in the Preview image box.

Create New Folder
If you choose the Create New Folder button, AutoCAD MEP creates a new folder with the 
name New Folder. The new folder is displayed in the File list box. You can change the 
name of the folder if required.

Up one level
When you choose the Up one level button, the folders that are up by one level are displayed. 
For example, if you are in the Sample subfolder of the AutoCAD MEP 2023 folder, then 
choosing the Up one level button will open the AutoCAD MEP 2023 folder.

Tools Drop-Down List
The Add/Modify FTP Locations option in the Tools drop-down list is used for adding or 
modifying the FTP sites. These sites can then be browsed from the FTP shortcut in the Places 
list. The Add Current Folder to Places and Add to Favorites options add the folder displayed 
in the Save in edit box to the Places list or to the favorites folder, respectively. The Options 
option displays the Saveas Options dialog box where you can save the proxy images of the 
custom objects. It has the DWG Options and DXF Options tabs. 
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AUTO SAVE
AutoCAD MEP allows you to save your work automatically at specific intervals. To change the 
time intervals, choose the Options button from the Application Menu; the Options dialog 
box will be displayed. In this dialog box, enter the duration after which the file will be saved 
automatically in the Minutes between saves text box in the File Safety Precautions area of 
the Open and Save tab. This duration depends on the power supply, hardware, and type of 
drawings. AutoCAD MEP saves the drawing with the file extension .ac$. You can also change 
the time interval by using the SAVETIME system variable. 

Tip
Although the automatic save feature saves your drawing upto a certain time interval, you should 
not completely depend on it because the procedure for converting the sv$ file into a drawing 
file is cumbersome. Therefore, it is recommended that you save your files regularly using the 
QSAVE or SAVEAS commands.

BACKUP FILES
If a drawing file already exists and you use the Save or Save As tool to update the current 
drawing, AutoCAD MEP creates a backup file. AutoCAD MEP takes the previous copy of the 
drawing and changes it from .dwg to .bak. The updated drawing is saved as a drawing file with 
the .dwg extension. For example, if the name of the drawing is myproj.dwg, AutoCAD MEP will 
change it to myproj.bak and save the current drawing as myproj.dwg.

Using the DRAWING RECOVERY MANAGER to Recover Files
The files that are saved automatically can also be retrieved by using the Drawing Recovery 
Manager. You can open the DRAWING RECOVERY MANAGER by choosing Drawing 
Utilities > Open the Drawing Recovery Manager from the Application Menu or by entering 
DRAWINGRECOVERY at the command bar.

In case of a system crash, the Drawing Recovery message box will be displayed on starting 
AutoCAD MEP again, refer to Figure 1-30. The message box informs you that the program 
unexpectedly failed and you can open the most suitable among the backup files created by 
AutoCAD MEP. Choose the Close button from the Drawing Recovery message box; the 
DRAWING RECOVERY MANAGER will be displayed on the left of the drawing area, as shown 
in Figure 1-31. 

Note
The DRAWING RECOVERY MANAGER will be available only when the automatic save 
feature is active.

The Backup Files rollout lists the original files, the backup files, and the automatically saved 
files. Select a file; its preview will be displayed in the Preview rollout. Also, the information 
corresponding to the selected file will be displayed in the Details rollout. To open a backup file, 
double-click on its name in the Backup Files rollout. Alternatively, right-click on the file name 
and then choose Open from the shortcut menu. It is recommended that you save the backup 
file at the desired location before you start working on it.
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Figure 1-30 The Drawing Recovery message box Figure 1-31  The DRAWING
RECOVERY MANAGER

EPD Backup Files
The Electrical Project Database is used to manage all drawings related to the electrical circuits 
for a project. As you create and modify electrical circuits for a project, you can use the circuit 
manager to view and manage panel and circuit information. By default, AutoCAD MEP creates 
a backup of all the EPD files. These backup files are used when the EPD files get corrupt due 
to system crash or when files get incorrectly linked. You can specify the number of data backup 
files in the Electrical Preferences dialog box displayed on choosing the Electrical button in 
the Preferences panel from the Manage tab of the Ribbon. You can create upto 99 backup files 
for a single Electrical Project Database.

CLOSING A DRAWING
You can use the CLOSE command to close the current drawing file without actually quitting 
AutoCAD MEP. To do so, choose Close > Current Drawing from the Application Menu or 
enter CLOSE at the command bar; the current drawing file will be closed. If multiple drawing 
files are open, choose Close > All Drawings from the Application Menu. If multiple drawing 
files of a single project are open, choose Close > All Project Drawings from the Application 
Menu. If you have not saved the drawing after making the last changes to it and you invoke the 
CLOSE command, AutoCAD MEP displays a dialog box that allows you to save the drawing 
before closing. This dialog box gives you an option to discard the current drawing or the changes 
made to it. It also gives you an option to cancel the command. After closing the drawing, you 
are still in AutoCAD MEP from where you can open a new or an already saved drawing file. You 
can also use the Close button (X) in the drawing area to close the drawing. 

Note
You can close a drawing even if a command is active. 
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OPENING AN EXISTING DRAWING
You can open an existing drawing file by using one of the following three methods: by using 
the Select File dialog box, by using the Create New Drawing dialog box, and by dragging and 
dropping.

Opening an Existing Drawing Using the Select File Dialog Box
If you are already in the drawing editor and you want to open a drawing file, choose the 
Open tool from the Quick Access Toolbar; the Select File dialog box will be displayed. 

Alternatively, invoke the OPEN command to display the Select File dialog box, refer to 
Figure 1-32. You can select the drawing to be opened using this dialog box. This dialog box is 
similar to the standard dialog boxes. You can choose the file you want to open from the folder 
in which it is stored. You can change the folder from the Look in drop-down list. You can then 
select the name of the drawing from the list box or you can enter the name of the drawing file 
you want to open in the File name edit box. After selecting the drawing file, you can choose the 
Open button to open the file.   

Figure 1-32  The Select File dialog box

When you select a file name, preview of the selected file is displayed in the Preview box. You 
can also use this box to identify the contents of a drawing. You can also change the file type by 
selecting it from the Files of type drop-down list. Apart from the dwg files, you can open the 
dws (standard), dwt (template) files or the dxf files. You have all the standard icons in the Places 
list that can be used to open drawing files from different locations. When you click on the down 
arrow adjacent to the Open button, a drop-down list is displayed, as shown in Figure 1-33. 
You can choose a method for opening the file using this drop-down list. These methods are 
discussed next.
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Figure 1-33  The Files of type drop-down list

Open Read-Only
To view a drawing without modifying it, select the Open Read-Only option from the drop-down 
list. If you try to save the opened drawing with the original file name, AutoCAD MEP warns you 
that the drawing file is write protected. However, you can save the edited drawing with a different 
file name using the SAVEAS command. This way you can preserve your drawing.

Partial Open
The Partial Open option enables you to open only a selected view or a selected layer of a selected 
drawing. This option can be used to edit small portions of a complicated drawing and then 
save it with the complete drawing. When you select the Partial Open option from the Open 
drop-down list, the Partial Open dialog box will be displayed, as shown in Figure 1-34, which 
contains different views and layers of the selected drawing. When you select a check box for a 
layer and then choose the Open button, only the objects drawn in that particular layer for the 
drawing are displayed in the new drawing window. You can make the changes and then save it. 

Figure 1-34  The Partial Open dialog box

Loading Additional Objects to Partially Opened Drawing
Once you have opened a part of a drawing and made the necessary changes, you may want to 
load additional objects or layers on the existing ones. To do so, enter PARTIALOAD at the 
command bar; the Partial Load dialog box will be displayed, which is similar to the Partial Open 
dialog box. You can choose another layer and the objects drawn in that layer will be added to 
the partially loaded drawing.
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Note
1. Loading a drawing partially is a good practice when you are working with objects on a specific  
    layer in a large complicated drawing. 
2. In the Select File dialog box, the preview of a drawing which was partially opened and then  
    saved is not displayed. 
  

Tip 
If a drawing is partially opened and saved previously, it is possible to open it again with the 
same layers and views. AutoCAD MEP remembers the settings, therefore when you open a 
partially opened drawing, a message box is displayed prompting you to fully open it or restore 
the partially opened drawing.

Select Initial View 
Select the Select Initial View check box if you want to load a specific view initially when AutoCAD 
MEP loads the drawing. This option will work if the drawing has saved views. This is generally 
used while working on a large complicated drawing, in which you want to work on a particular 
portion. You can save that particular portion as a view and then select it to open the drawing 
next time. You can save the desired view by using the VIEW command. If the drawing has no 
saved views then on selecting this option, the last view will be loaded. If you select the Select 
Initial View check box and then the OK button, AutoCAD MEP will display the Select Initial 
View dialog box. You can select the view name from this dialog box, and AutoCAD MEP will 
load the drawing with the selected view.

Opening an Existing Drawing Using the Startup Dialog Box
If you have set the STARTUP system variable value as 1, the Startup dialog box will be displayed 
whenever you start a new AutoCAD MEP session. The first button in this dialog box is the Open 
a Drawing button. When you choose this button, a list of the most recently opened drawings 
will be displayed for you to select from, refer to Figure 1-35. The Browse button displays the 
Select File dialog box, which allows you to browse to another file.

Figure 1-35 List of the recently opened drawings



1-32			                	       AutoCAD MEP 2023 for Designers
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Note
The display of the dialog boxes related to opening and saving drawings will be disabled, if the 
STARTUP and the FILEDIA system variables are set to 0. 

Opening an Existing Drawing Using the Drag and Drop Method
You can also open an existing drawing in AutoCAD MEP by dragging it from the Window 
Explorer and dropping it into AutoCAD MEP. If you drop the selected drawing in the drawing 
area, the drawing will be inserted as a block. As a result, you cannot modify it. But if you drag 
the drawing from the Windows Explorer and drop it at any place other than the drawing area, 
AutoCAD MEP opens the selected drawing. 

QUITTING AutoCAD MEP
You can exit the AutoCAD MEP program by using the EXIT or QUIT command. Even if you 
have an active command, you can choose Exit AutoCAD MEP 2023 from the Application Menu 
to quit the AutoCAD MEP program. In case the drawing has not been saved, a dialog box is 
displayed with the Yes and No buttons. Choose the Yes button to save the drawing. Note that if 
you choose No in this dialog box, all the changes made in the current list till the last save will 
be lost. You can also use the Close button (X) of the main AutoCAD MEP window to end the 
AutoCAD MEP session. 

CREATING AND MANAGING WORKSPACES
A workspace is defined as a customized arrangement of Ribbon, toolbars, menus, and window 
palettes in the AutoCAD MEP environment. You can create your own workspaces, in which only 
specified toolbars, menus, and palettes are available. When you start AutoCAD MEP, by default 
the HVAC workspace is displayed as the current workspace. However, you can select any other 
predefined workspace from the flyout displayed on choosing the Workspace Switching from 
the Application Status Bar, refer to Figure 1-36. You can also set the workspace by using the 
WORKSPACE command. 

Figure 1-36  The predefined workspaces
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Creating a New Workspace
To create a new workspace, customize the Ribbon and invoke the palettes to be displayed in the 
new workspace. Next, choose the Save Current As option from the flyout displayed on choosing 
the Workspace Switching button from the Application Status Bar; the Save Workspace dialog 
box will be displayed, as shown in Figure 1-37. Enter the name of the new workspace in the 
Name edit box and choose the Save button. 

Figure 1-37  The Save Workspace dialog box

The new workspace is now the current workspace and is added to the drop-down list in the 
title bar. Similarly, you can create workspaces based on your requirement and switch from 
one workspace to another by selecting the name from the flyout displayed on choosing the 
Workspaces Switching button from the Application Status Bar. 

Modifying the Workspace Settings
AutoCAD MEP allows you to modify the workspace settings. To do so, choose the Workspace 
Settings option from the flyout displayed on choosing the Workspaces Switching button from 
the Application Status Bar; the Workspace Settings dialog box will be displayed, as shown in 
Figure 1-38. All workspaces are listed in the My Workspace drop-down list. You can make any 
of the workspaces as My Workspace by selecting it from the My Workspace drop-down list. The 
options in the Workspace Settings dialog box are discussed next.

Menu Display and Order Area
The options in this area are used to control the display and the order of display of workspaces 
in the Workspace Switching drop-down list. By default, workspaces are listed in the sequence 
of their creation. To change the order, select a workspace and choose the Move Up or Move 
Down button. To control the display of the workspaces, you can select or clear the check boxes. 
You can also add a separator between workspaces by choosing the Add Separator button. A 
separator is a line that is placed between two workspaces in the flyout displayed on choosing 
the Workspaces Switching button from the Application Status Bar, as shown in Figure 1-39. 
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Figure 1-39  The flyout displayed on 
choosing the Workspaces Switching button 

Figure 1-38  The Workspace Settings dialog box

When Switching Workspaces Area
By default, the Automatically save workspace changes radio button is selected in this area, 
so the changes made in the current workspace will be automatically saved when you switch to 
the other workspace. If you select the Do not save changes to workspace radio button then 
while switching the workspaces, the changes made in the current workspace will not be saved. 
Therefore, when you invoke this workspace again, it will be displayed with default settings. 

AutoCAD MEP HELP
You can get the on-line help and documentation about the

 Figure 1-40  The Help menu

 
working of AutoCAD MEP 2023 commands by using the 

options from the Help menu in the title bar, refer to Figure 1-40. 
You can access AutoCAD MEP’s help by pressing the F1 function 
key. On pressing the F1 function key, the AutoCAD MEP 2023 - Help 
will be displayed, as shown in Figure 1-41. The entire help 
documentation on AutoCAD MEP 2023 is available on this page. 
You can search for information about any command or tool on this 
page. You can access this page without the internet connection also. 
But if you want to use the offline help then you need to download the help file first. You can 
download the offline help from Autodesk website. Some important options in the Help menu 
are discussed next.
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Figure 1-41  The Autodesk AutoCAD MEP 2023 - Help window

About AutoCAD MEP 2023
This option gives you information about the release, serial number, license number, and also 
the legal description about AutoCAD MEP.
 

InfoCenter BAR
An InfoCenter bar is displayed at the top right corner in the title bar that will help you sign 
into the Autodesk Online services, refer to Figure 1-42. You can also access AutoCAD MEP 
community by using certain keywords.

Figure 1-42  The InfoCenter bar

ADDITIONAL HELP RESOURCES
•	 You can get help for a command by pressing the F1 key while working. The help page thus 

obtained contains information about the selected command. You can exit the dialog box 
and continue with the command.

•	 You can get help about a dialog box by choosing the Help button in that dialog box.

•	 Autodesk has provided several resources that you can use to get assistance with your AutoCAD 
MEP questions. The following is a list of some of the resources:

	 a. 	 AutoCAD MEP Technical Assistance website: https://knowledge.autodesk.com
	 b.	 AutoCAD MEP Discussion Groups website:  https://forums.autodesk.com/t5/autocad-forum/
             bd-p/706
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•	 You can also get help by contacting the author, Prof. Sham Tickoo, at stickoo@pnw.edu and 
tickoo525@gmail.com.

 Self-Evaluation Test 
Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 To restrict the movement of cursor along a specific angle, you need to turn on the __________ 
snap.

2.	 Using the __________ command, you can change the time interval of automatic save.

3.	 The Startup dialog box is displayed when the STARTUP variable is set to __________ .

4.	 You can sign into the Autodesk Online Services by using the options available in the 
__________ bar.

5.	 You can increase the display area of the screen by using the Clean Screen button available 
in the Application Status Bar. (T/F) 

6.	 The AutoCAD Text Window is used to write text in the drawing area. (T/F) 

7.	 The Isolate Objects button is used to display or hide the selected object. (T/F) 

8.	 The CLOSE command is used to close the AutoCAD MEP application. (T/F)

Answers to Self-Evaluation Test  
1. Polar Tracking, 2. SAVETIME, 3. 1, 4. InfoCenter, 5. T, 6. F, 7. T, 8. F


